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1.1 GETTING STARTED

The Carbon Dioxide from Fossil Fuel Combustion (CO2FFC) module was developed using
Microsoft® Excel 2000. While the module will operate with older versions of Excel, it
functions best with Excel 2000 or later. If you are using Excel 2007 or later, instructions for
opening the module will vary as outlined in the Excel basics below. Before you use the
CO2FFC module, make sure your computer meets the system requirements. In order to
install and run the CO2FFC module, you must have:

e IBM-PC compatible computer with the Windows 95 operating system or later;

e Microsoft® Excel 1997 or later, with calculation set to automatic and macros
enabled;

e Hard drive with at least 20MB free; and

e Monitor display setting of 800 x 600 or greater.

Microsoft Excel Settings

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to
automatic calculation. To check this setting, launch Microsoft Excel before opening the
CO2FFC module. Go to the Tools menu and select “Options...” Click on the “Calculations”
tab and make sure that the radio button next to “"Automatic” is selected, and then click on
"OK"” to close the window. The security settings (discussed next) can also be adjusted at
this time.

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to
automatic calculation. Go to the Formulas ribbon and select “Calculation Options.” Make
sure that the box next to the “"Automatic” option is checked from the pop-up menu.

Microsoft Excel Security

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security
set to medium (recommended) or low (not recommended). To change this setting, launch
Microsoft Excel before opening the CO2FFC module. Once in Excel, go to the Tools menu,
click on the Macro sub-menu, and then select “Security” (see Figure 1). The Security pop-
up box will appear. Click on the “Security Level” tab and select medium. When set to high,
macros are automatically disabled; when set to medium, Excel will give you the choice to
enable macros; when set to low, macros are always enabled.

When Excel security is set to medium, users are asked upon opening the module whether to
enable macros. Macros must be enabled in order for the CO2FFC module to work. Once
they are enabled, the module will open to the control worksheet. A message box will
appear welcoming the user to the module. Clicking on the “x” in the upper-right-hand
corner of the message box will close it.

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security
Warning appears above the formula box in Excel when the CO2FFC module is initially
opened. The Security Warning lets the user know that some active content from the
spreadsheet has been disabled, meaning that Excel has prevented the macros in the
spreadsheet from functioning. Because SIT needs macros in order to function properly, the
user must click the “"Options” button in the security message and then select, “"Enable this
content” in the pop-up box. Enabling the macro content for the SIT in this way only enables
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macros temporarily in Excel but does not change the macro security settings. Once macros
are enabled, a message box will appear welcoming the user to module. Click on the “"x” in
the upper right-hand corner to close the message box.

If the Security Warning does not appear when the module is first opened, it may be
necessary to change the security settings for macros. To change the setting, first exit out
of the CO2FFC module and re-launch Microsoft Excel before opening the CO2FFC module.
Next, click on the Microsoft Excel icon in the top left of the screen. Scroll to the bottom of
the menu and select the “Excel Options” button to the right of the main menu. When the
Excel Options box appears, select "Trust Center” in left hand menu of the box. Next, click
the gray “Trust Center Settings” button. When the Trust Center options box appears, click
“Macro Settings” in the left hand menu and select “Disable all macros with notification.”
Once the security level has been adjusted, open the Stationary Combustion module and
enable macros in the manner described in the preceding paragraph.

Viewing and Printing Data and Results

The CO2FFC module contains some features to allow users to adjust the screen view and the
appearance of the worksheets when they are printed. Once a module has been opened, you
can adjust the zoom by going to the Module Options Menu, and either typing in a zoom
percentage or selecting one from the drop down menu. In addition, data may not all appear
on a single screen within each worksheet; if not, you may need to scroll up or down to view
additional information.

You may also adjust the print margins of the worksheets to ensure that desired portions of
the CO2FFC module are printed. To do so, go to the File menu, and then select “Print
Preview.” Click on “Page Break Preview” and drag the blue lines to the desired positions
(see Figure 2). To print this view, go to the File menu, and click “Print.” To return to the
normal view, go to the File menu, click “Print Preview,” and then click "Normal View.”
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1.2 MoODULE OVERVIEW

This User’s Guide accompanies and explains the CO2FFC module of the SIT. The SIT was
originally developed in conjunction with EPA’s Emissions Inventory Improvement Program
(EIIP) in order to automate the steps states would need to take in developing their own
emission estimates in a manner that was consistent with prevailing national and state
guidelines. The result was a user-friendly and comprehensive set of eleven modules that
help users estimate greenhouse gas emissions at the state level.

Because most state inventories developed today rely heavily on the SIT, User’s Guides have
been developed for each of the SIT modules. These User’s Guides contain the most up-to-
date methodologies that are, for the most part, consistent with the Inventory of U.S.
Greenhouse Gas Emissions and Sinks (EPA 2024a). Users can refer to the chapters and
annexes of the U.S. Inventory to obtain additional information not found in the SIT or in the
companion User’s Guide.

In 2024, EPA published the results of the 2022 Inventory of U.S. Greenhouse Gas Emissions
and Sinks disaggregated by U.S. state (EPA 2024b) to make consistent state-level GHG data
available for all states for use by states, researchers, and the general public. However, EPA
recognizes that there will be differences between the state-level estimates published by EPA
and inventory estimates developed by states using the SIT or other tools. Inventories
compiled by states may differ for several reasons, and differences do not necessarily mean
that one set of estimates is more accurate, or "correct." In some cases, the Inventory of
U.S. Greenhous Gas Emissions and Sinks may be using different methodologies, activity
data, and emission factors, or may have access to the latest facility-level information
through the Greenhouse Gas Reporting Program (GHGRP). In other cases, because of state
laws and regulations, states may have adopted accounting decisions that differ from those
adopted by UNFCCC and IPCC to ensure comparability in national reporting (e.g., use of
different category definitions and emission scopes consistent with state laws and
regulations). Users of state GHG data should take care to review and understand
differences in accounting approaches to ensure that any comparisons of estimates are
equivalent or an apples-to-apples comparison of estimates.

The CO2FFC module calculates carbon dioxide (CO2) emissions from the fuel types shown in
Table 1 by end-use sector. While the module provides default data for fuel types
(depending on availability), users are encouraged to use state-specific data, where
available. If using outside data sources, or for a more thorough understanding of the tool,
please refer to the following discussion for data requirements and methodology.

1.2.1 Data Requirements

To calculate CO2 emissions from fossil fuel combustion,! the following data are required:

e Fossil fuel energy and non-energy consumption by fuel type and sector (non-energy
consumption applies only to the industrial sector);

1 For this discussion, CO, emissions from fossil fuel combustion include all of the carbon in fuels that is
either immediately oxidized or oxidized within a short time period (i.e., less than 20 years). It thus
includes carbon in the form of gases, like carbon monoxide. It also includes short-lived products that
will be burned after use or decompose quickly.
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e Carbon content coefficients;
e Carbon stored in products; and

e Percentage of carbon oxidized during combustion.

Because the carbon content of fossil fuels varies by fuel type, it is necessary to compile
consumption data for each type of fuel (the recommended list of fuels is provided in Table
1).

Energy consumption statistics should be collected on

an energy basis—preferably in British thermal units Box 1: Energy Units
(Btu). Statistics providing energy consumption data A British thermal unit (Btu) is the quantity

A . of heat required to raise the temperature of
in other units, such as barrels or tons, may be used, one pound of water one degree Fahrenheit
but require conversion to Btu by using the heat at or near 39.2° Fahrenheit.

content of the specific fuel. If the conversion to Btu British thermal unit 1 Btu
energy units is necessary, the heat contents that MBtu Thousand Btu 1x103 Btu
were used should be documented (default heat MMBtu  Million Btu 1x108 Btu
contents are provided in the CO2FFC module). BBtu Billion Btu 1X1osztU
Please note that even data given in Btu may be gBBttLl‘J gﬂ':g:‘m?gﬁ Bty 1?1815 SEE
preceded by a prefix indicating order of magnitude

(i.e. thousand, million, billion). For a better

understanding of the quantity prefixes used with Btu,
refer to Box 1.

Box 2: Caution When Using Non-Default Fuel Consumption Data

If you decide to use fuel consumption data that is different from the default, please be aware of
the following possible data problems:

In some cases (e.g., the default EIA’s State Energy Consumption, Price, and Expenditure
Estimates (EIA/SEDS) data) fuel consumption statistics can include data that is at odds with the
methodology used in the CO2FFC module. For example, SEDS motor gasoline consumption
includes ethanol that is blended into gasoline. Ethanol is not a fossil fuel, and thus the default
data in the CO>FFC module has been adjusted to remove the portion of blended gasoline known
to be ethanol. If you use external data sources, be sure to determine whether ethanol or other
biofuels (e.g., biodiesel) are included in total consumption for any particular fuel type. If so,
you must subtract the biofuel portion before entering the data into the CO,FFC module. State
ethanol data can be obtained from the Federal Highway Administration’s annual Highway
Statistics report (FHWA 2022) and are taken into account with default data provided in the
CO2FFC module.

Users should also be aware of double counting. For example, EIA’s SEDS data for industrial coal
consumption includes coal used to make synthetic natural gas, which is accounted for in both
industrial coal and natural gas consumption data. This double-counting issue has been
corrected for in the default dataset contained in the CO,FFC module; similar adjustments may
need to be made to outside data sources. State-specific natural gas data can be obtained from
Table 12 of EIA’s Historical Natural Gas Annual EIA (EIA 2001) and Table 8 of EIA’s Natural Gas
Annual EIA (EIA 2024b) (and is also provided in the CO>FFC module).
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Table 1. Fuel Types Consumed by Sector

Electric International
Residential Commercial | Industrial Transportation | Utilities Bunker Fuels
Coal Coal Coking Coal Coal Coal
Other Coal
Natural Gas | Natural Gas Natural Gas Natural Gas Natural Gas
Petroleum: Petroleum: Petroleum: Petroleum: Petroleum: Petroleum:
Distillate Fuel | Distillate Fuel Distillate Fuel Distillate Fuel Distillate Jet Fuel,
Kerosene Kerosene Kerosene Hydrocarbon Fuel Kerosene
Hydrocarbon Hydrocarbon LPG Gas Liquids Residual Distillate Fuel
Gas Gas Motor Gasoline Motor Gasoline Fuel Residual Fuel
Liquids Liquids Residual Fuel Residual Fuel Petroleum
Motor Lubricants Lubricants Coke
Gasoline Asphalt/Road Aviation
Residual Fuel Oil Gasoline
Crude Oil Jet Fuel,
Feedstocks Kerosene
Misc. Jet Fuel,
Petroleum Naphtha
Products
Petroleum
Coke
Pentanes Plus
Still Gas
Special
Naphthas
Unfinished Oils
Waxes
Aviation
Gasoline
Blending
Components
Motor Gasoline
Blending
Components
Other (e.g. Other (e.g. Other (e.g. Other (e.g. Other (e.g.

geothermal)

geothermal)

Source: U.S. EPA 2024a.

geothermal)

geothermal)

geothermal)
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1.2.2 Tool Layout

Because there are multiple steps to complete within the CO2FFC module, it is important to
have an understanding of the module’s overall design. The layout of the CO2FFC module
and the purpose of its worksheets are presented in Figure 3.

Figure 3. Flow of Information in the CO2FFC Module*

Control Worksheet 3. Bulk Data Worksheet
1. Choose a State l Enter energy consumption for all sector by fuel type
Individual Sector Worksheets
2. Enter the following variables by fuel type: /4. Residential
Combustion Efficiencies | Wiew consumption data and emission factors
Carbon Contents 5. Commercial
Non-Energy Use Storage Factors | Wiew consumption data and emission factors

3. Complete Bulk Data Worksheet 6. Transportation
< | Wiew consumption data and emission factors
4.t0 9, Complete Sector Worksheet 7. Electric power

| Wiew consumption data and emission factors
8. Bunker fuels

10. View Summary Datg
| Wiew consumption data and emission factors
11. Export Data \59. Industrial
Enter non-energy consumption for each fuel type
Summary Data
l Presented in both table and graphical formats in MMTCO;E
Uncertainty

Review information on uncertainty associated with the default data

* These worksheets are the primary worksheets used in the CO2FFC module; subsequent worksheets are used to
populate the default data and are provided for informational purposes only.

1.3 METHODOLOGY

This section provides a guide to using the CO2FFC module of the SIT to estimate CO:2
emissions from sectors that consume fossil fuels. Within the CO2FFC module, these sectors
are residential, commercial, industrial, transportation, electric power, and bunker fuels.

Because the methodology is similar in

all sectors, a general methodology is Box 3: State Energy Data Sources
discussed and specific examples for

each sector are provided. In-state sources, such as state energy commissions or public

utility commissions, should be consulted first. Otherwise,
. default data provided by the CO2FFC module may be used.
The CO2FFC module automatically Fossil fuel statistics should be provided on an energy basis

calculates emissions after you enter (e.g., in Btu).

energy consumption data (and the
factors on the control worksheet). The tool provides default energy consumption data,
which comes from the EIA’s State Energy Consumption, Price, and Expenditure Estimates
(SEDS) (EIA 2024a).2 Default energy consumption data for vessel bunkering use of
distillate fuel oil and residual fuel oil comes from the EIA’s Fuel Oil and Kerosene Sales
(FOKS) (EIA 2022).3 However, other state-specific data may be used if available (see Box 3
for suggestions on where to find data).

2 These data are available at https://www.eia.gov/state/seds/.

3 These data are available at https://www.eia.gov/petroleum/fueloilkerosene/.
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The CO2FFC module follows the general methodology from the National Inventory Report
(NIR) GHG Inventory by U.S. State. However, SIT includes emissions from the non-energy
use of fossil fuels within the total emission estimates produced by the CO2FCC module, while
the NIR reports these separately. SIT also provides an alternative approach to estimating
CO2 emissions from transportation utilizing vehicle miles traveled (VMT); this approach is
calculated in the Mobile Module. SIT also includes an optional module to estimate emissions
associated with electricity consumption.

This User’s Guide provides an overview of the estimation methodology used in the CO2FFC
module by walking through the following eleven steps: (1) select a state; (2) fill in the
variables used throughout the module; (3) complete the bulk data energy consumption
worksheet; (4) complete the residential sector worksheet; (5) complete the commercial
sector worksheet; (6) complete the transportation sector worksheet; (7) complete the
electric power sector worksheet; (8) complete the bunker fuels sector worksheet; (9)
complete the industrial sector worksheet; (10) review summary information; and (11)
export data.

The general equation used to calculate CO2 emissions from fossil fuel combustion is shown
in Equation 1. The equation used for fuels in the industrial end-use sector is similar, but
includes the non-energy use of fuels, as shown in Equation 2.

Equation 1. General Emission Equation
Emissions (MMTCO:zE) =
Consumption (BBtu) x Emission Factor (Ibs C/BBtu) x 0.0005 short ton/lbs x Combustion
Efficiency (% as a decimal) x 0.9072 (Ratio of Short Tons to Metric Tons) = 1,000,000 x
(44/12) (to yield MMTCO:zE)

Equation 2. Emission Equation for the Industrial Sector*

Emissions (MMTCO:zE) =
(Total Consumption (BBtu) — [Non-Energy Consumption (Bbtu) x Storage Factor (%)])
x Emission Factor (Ibs C/BBtu) x Combustion Efficiency (% as a decimal)
x 0.9072 (Ratio of Short Tons to Metric Tons) + 1,000,000 x (44/12) (to yield MMTCO:zE)

* This equation also applies to lubricants consumed in the transportation end-use sector.
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Box 4: Treatment of Biofuels in the SIT

The CO; from Fossil Fuel Combustion (CO,FFC) module relies on EIA's SEDS database for state-
level energy consumption data. The SEDS data provides consumption estimates at the state
level for ethanol blended into gasoline. Ethanol is not a fossil fuel, and thus the default data in
the CO2FFC module has been adjusted to remove the portion of blended gasoline known to be
ethanol.

Ideally, biodiesel blended into diesel fuel and other biofuels blended into heating fuels, etc.
should be treated in the same way to avoid counting emissions from non-fossil fuels. However,
due to the lack of state-level data on biofuel consumption, it is not feasible to adjust the default
consumption data in the CO,FFC module to account for these biofuels at this time. The user
should note that this may lead to some overestimation of emissions from fuel consumption by
not considering all blended biofuels. EPA is continuously monitoring data availability and
methodologies that will allow for biofuel adjustments in future versions of the CO,FFC module.

Users are encouraged to adjust the default data and/or enter their own data for diesel and
heating oil consumption if available, especially if the user has access to biodiesel and/or biofuel
consumption within their state. Users should refer to the CO,FFC User's Guide for more
guidance on entering non-default fuel consumption data.

Users are also encouraged to refer to EIA's documentation for SEDS energy consumption data
for more information regarding the fuels included in the COFFC module.

Step (1) Select a State

To begin, select the state you are interested in evaluating. By selecting a state, the rest of
the tool will automatically reset to reflect the appropriate state default data and
assumptions for use in subsequent steps of the tool.

Step (2) Fill in the Variables Used Throughout the Module

Step 2 requires users to select appropriate factors for several key variables necessary for
estimating CO2 emissions from fossil fuel combustion. This can be done by selecting the
default data provided or entering user-specified, fuel-specific data for combustion
efficiencies, carbon contents, and non-energy use storage factors that will be used
throughout the tool. To select the default data, select the “Clear/Select All Defaults” button
for each group of variables (combustion efficiency, carbon content, and non-energy use
storage factors) or check the default box directly to the right of individual yellow input cells.
Note that users may select a default value and later override it if better data becomes
available. To enter state-specific data from other sources, enter values directly into the
yellow input cells. If the user-specific inputs do not match the default data in the control
worksheet (i.e., the default value is overwritten), the text will appear red. See Figure 4 for
locations of the “Clear/Select All Defaults” buttons, individual default check boxes, and
yellow input cells. Information for combustion efficiencies, carbon contents, and non-
energy use storage factors are discussed individually below.
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The first type of required data in the control worksheet is combustion efficiency (percent
carbon oxidized). This percent is applied if the carbon is not completely oxidized during the
combustion of fossil fuels. The fraction oxidized was assumed to be 100 percent for
petroleum, coal, natural gas, and LPG based on guidance from IPCC (2006). If values other
than module defaults are available for state-level combustion, they should be used and

documented. Combustion efficiencies are used throughout the module and are pulled into
each sector’s worksheet. Figure 5 presents an example of the combustion efficiency used in
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the commercial sector worksheet. If the user-specific inputs do not match the default data
in the control worksheet (i.e., the default value is overwritten), the text will appear red.

Figure 5. Example of Combustion Efficiency Data Applied in the Commercial
Worksheet
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| 37 | Motor Gascline O 1238 « 00| = o0 | = nnﬁ - nnsﬂ
38 | Residul Fus! [ 45| & 0oox| = M| = oo = UE‘

—e 1

Carbon Contents

The second type of data required for the control worksheet is the carbon content data,
which is also pulled into the individual sector worksheets (depending on whether the fuel
type is represented in the sector). The carbon content coefficients used in the CO2FFC
module are from the EPA’s Inventory of GHG Emissions (EPA 2024a). States are
encouraged to use more detailed data if it is available and well documented. If the user-
specific inputs do not match the default data in the control worksheet (i.e., the default value
is overwritten), the text will appear red.

Carbon content represents the maximum amount of carbon emitted per unit of energy
released, assuming 100 percent combustion efficiency. Coal has the highest carbon content
of the major fuel types, petroleum has roughly 79 percent of carbon per energy as
compared to coal, and natural gas has about 57 percent. However, carbon contents also
vary within the major fuel types, as noted below:

e Carbon emissions per ton of coal vary considerably depending on the coal's composition
of carbon, hydrogen, sulfur, ash, oxygen, and nitrogen. While variability of carbon
emissions on a mass basis can be considerable, carbon emissions per unit of energy
(e.g., per Btu) vary less.
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e The carbon/energy ratio of different petroleum fractions generally correlates with API
(American Petroleum Institute) gravity (Marland and Rotty 1984).4 Lighter fractions
(e.g., gasoline) usually have less carbon per unit energy than heavier fractions (e.g.,
residual fuel oil).

e Natural gas is a mixture of several gases, and the carbon content depends on the
relative proportions of methane, ethane, propane, other hydrocarbons, CO>, and other
gases, which vary from one gas production site to another.

Non-Energy Use Storage Factors

The third and final type of data requested in the control worksheet is the percent of carbon
in each fuel that is stored from non-energy uses. Many fossil fuels have potential non-
energy uses. For example, LPG is used for production of solvents and synthetic rubber; oil
is used to produce asphalt, naphthas, and lubricants; and coal is used to produce coke,
yielding crude light oil and crude tar as by-products that are used in the chemical industry.

However, not all non-energy uses of fossil fuels result in carbon storage. For example, the
carbon from natural gas used in ammonia production is oxidized quickly; many products
from the chemical and refining industries are burned or decompose within a few years; and
the carbon in coke is oxidized when the coke is used. The CO2FFC module provides national
default values for storage factors, but state-level fractions may differ depending on the type
of non-energy uses. Where state-specific estimates are available, their use is preferred, if
adequate supporting documentation is available. If the user-specific inputs do not match the
default data in the control worksheet (i.e., the default value is overwritten), the text will
appear red. Data on the non-energy use storage factor is used in the industrial sector
worksheet (Step 9).

Step (3) Complete the Bulk Energy Consumption Data Worksheet

The energy consumption data entered in the "Bulk Energy Consumption Data” (bulk data)
worksheet feed into the calculation worksheets for each sector. Modifying the consumption
data in this worksheet will change the consumption estimates on each sector calculation
sheet. The default data will automatically be populated in the yellow cells by sector and fuel
type for the selected state. On the bulk data worksheet, presented as an example in Figure
6, the yellow cells indicate where the required energy activity data are entered either
manually or automatically from default data. Default data in the yellow cells on this
worksheet can be overwritten with state-specific data. To revert to default data for all
sectors and fuel types, click on the "Refresh Default Data" button at the top of the
worksheet. Click on the "Proceed to Calculation Worksheet" to begin/continue estimating
emissions, or click on the “"Return to Control” button to return to the control worksheet.

4 variations in petroleum are most often expressed in terms of specific gravity at 15 degrees Celsius.
The API gravity, where API gravity = 141.5/specific gravity - 131.5, is an indication of the molecular
size, carbon/hydrogen ratio, and hence carbon content of a crude oil.
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Figure 6. Example of the Required Energy Consumption Data in the Bulk Data
Worksheet

i8] Fle Edt Module Options
c | D I E I F I G I H I ! I J I K I L I ] I
1 |Default Energy Consumption in Arkansas, billion btu (Bbtu)
i The energy consumption data entered in the table below feeds into the calculation workshests for each sector. Modifing the consurmption data below will change the|
consumption estimates on each sector calculation sheet. To modify the inputs helow:
1. Overwrite default data provided in the yellow cells with available state-specific data. Shest
2. To revert hack to default data for all sectors and fuel types, click on the "Refresh Default Data” bution below.
3. Click on the "Proceed to Calculation " to hegin/contin
Refresh Default Data ‘ Proceed to Calculation Worksheet
| |
5 |Sector and Fuel 1990 hu 1992 1993 1994 1995 1996 97 1993 1999
6 |Commercial Coal i a7 T \\8' EFM 16 7 = v = v 17 17 [
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[ 9 [commem— L 468 T r - 27 7 1007 7 Return to Control e
| 10jcnme  Refresh Default Data "] Proceed to Calculation [/ 191 z z > e
11 |Camme 321 004 29,724 31,823 29,852 28,759 28,387
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| 23 | Tndusteial Aviation Gasoling Blending Components [ " [ [ 26 " 22" 30" 3" 16 " 24"
| 24 | Industrial Coal i 5839 " 5839 " 7078 " 7748 " 8599 " 7784 " 8,356 6,080 " 7004 " 7927 "
| 25 | Industrial Coking Coal i -7 - - - - - - - - -
| 36 | Tndustrial Crude il B a - - a a a a
(27 | Industrial Distillate Fuel Required Energy Data 18,487 " 18,380 " 23511 " 19,764 " 23,285 " 22228 " 20563 "
28 | Industrial Feedstocks, Naphtha less than 401 F 695 " 788 " 738 " 8640 " 660 " 10827 " aps "~
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Step (4) through Step (7) View Emission Estimates on Individual Sector
Worksheets (Excluding International Bunker Fuels and Industrial Sector)

With the exception of the industrial sector, the worksheets for each sector have the same
basic set-up. On the residential sector worksheet, presented as an example in Figure 7, the
cells in the first column indicate where the required energy activity data were entered from
the bulk data worksheet. These activity data are converted into CO2 emissions using the
factors entered on the control worksheet, the energy consumption data entered on the bulk
data worksheet, and the formula presented in Equation 1. Click on the orange "Click here
for the bulk data worksheet." button to return to the energy consumption data entry
worksheet.

The activity data used to populate the energy consumption input cells is annual fuel
consumption based on primary fuel type (e.g., coal, petroleum, and natural gas) and
secondary fuel type (e.g., gasoline, residual oil, natural gas, etc.) by sector (e.g.,
residential, commercial, industrial, transportation, and electric utilities). A list of potential
fuel types consumed in each sector is provided in Table 1 and is included in the CO2FFC
module.

The CO2FFC module calculates emissions for each sector by multiplying consumption by the
carbon content and the combustion efficiency to obtain the total carbon oxidized. Then, the
total tons of carbon oxidized are converted into MMTCO:2E, by multiplying by the ratio of
metric tons per short ton (0.9072) to obtain metric tons and dividing by 10% and multiplying
by 44/12 to express emissions in MMTCO:zE (Equation 1).
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Figure 7. Example of the Required Energy Data Applied in the Residential
Worksheet

E state Inventory Tool - CO2 Emissions from Combustion of Fossil Fuel
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Step (8) View Estimates on Bunker Fuels Worksheet

Emissions from international bunker fuels are calculated in step 7. International bunker
fuels are fuels used in marine and aviation transport originating in the United States with
international destinations. According to the Revised 1996 IPCC Guidelines, emissions from
international transport should be reported separately as a memo item, instead of allocating
them to a particular country.

Step (9) Complete Non-Energy Use Activity Data on the Industrial Sector
Worksheet

The industrial worksheet is unique because both total energy consumption and total non-
energy consumption are required as inputs to calculate CO2 emissions, shown in Figure 8
(input cells are shown in green). Including activity data on non-energy use allows
calculation of the amount of carbon from these fuels that is stored in non-energy products
for a significant period of time (i.e., more than 20 years). The CO2FFC module estimates
carbon stored in non-energy uses for each state by multiplying the total number of Btu
consumed by the default percent of that fuel type that is used for non-energy purposes, and
then by a storage factor (i.e., the amount of carbon in non-energy uses that typically
remains stored for longer than 20 years, entered in Step 2). This non-energy consumption
is then subtracted from the total consumption to yield the net combustible consumption.
From this point forward, the industrial worksheet functions in the same manner as the other
sector worksheets. The net combustible consumption is multiplied by the carbon content
and the combustion efficiency to obtain the total carbon oxidized. Then, the total tons of
carbon oxidized are converted into MMTCO:2E, by multiplying by the ratio of metric tons per
short ton (0.9072) to obtain metric tons and dividing by 10 and multiplying by 44/12 to
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express emissions in MMTCO2zE (Equation 2). Click on the orange "Click here for the bulk
data worksheet." button to return to the energy consumption data entry worksheet.

Figure 8. Example of Energy and Non-Energy Consumption Data Applied in the
Industrial Worksheet
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] Fle Edt Module Options
A [ s [el o JTe[ F Jo[ H [ Tl Il v ol v Tel ®r [ s ]
1 |8. Industrial Consumption and CO2 Emissions in Colorado
2 |
Click here for (€0, emissions from fossil fusl combustion in the industrial sector are calelated by first subtracting non-energy consumption muliplied by carbon storage Go ta the MWTCO,
possible data factors from the energy consumption for each fusltype. The resuting combustidle consumption far each fuelis then mutipied by a carbon contert Summary Sheet
sources. coetficient anct by the percentage of caron oxidized during combustion ('combLstion etficiency”). The resuing Tusl emissions, in pounets of carbon, are
ihen converted to shorttons of carbon and milion metric tons of catbon equivelent (MMTCE}, then to milion metric tons of carbon dioxide equivalert Q
(MMTCOLE), and summed. Hot that cietault emission factors are avalablethrough 2008, To faciitats emission caiculations for later yesrs, the ool utiizes Gime Al EEEs
click here for 2008 emission factors as proxies for emission factors in subsequent years (2009 through 2020). Emission factors for 2009 and beyond wil be updsted as
the bulk dafa s00n &5 nev data become avalabie. For further detall on this method, retfer to COFFC Chapter in the User's Guide. Click on the arange "Click here for the Qﬂw Al
worksheet bk data workshest* button 1o return to the energy consumption data entry workshest
3
4 | Industrial Sector 1990 ¥ Default Non-Energy Consumption Data?
5 Total Mon-Energy Net combustible
E Consumption Consumption Consumption Emission Factor  Combustion Emissions Emissions Emissions
| 7 |Fuel Type (Billion Btu) (Billion Bu)  Storage Factor (%) _(Billion Btu) _  (Ibs CiMillion Btu) Efficiency () (short tons carbon) (MMTCE) (MMTCO,E)
8 |CokingCoal ot ' 10%] v [ omg 000 = = =
| 9 | oterCoal Bz -l M| 0] 1: [ B | 1 fl = 1| =
10 | Asphalt and Road 01 e | - 261 | x et L L =
Ayiation Gasoline Blending -
| 11 |Components 1 | =l Required Non-Energy z| =
12 | Crude 0l o i . A -
13 | Disils Fuel Eraa| - 0| e = Consum ption Data WIgE | =
Feedstocks, Naphtha s than
14 |401F ( il 5} =
Feedstacks, Other Cils greater
15 | than 401 F . ( . i A - - . -
| 16 |Kerosene 03| - il [ 0| 4337 28| =
1 LPG 3833 -( 2493 ] 203 ] ITAE| @ 39.260 =
18 | Lubricants 1481 [ ‘.g\ " 1347 ] 4397w 29825 =
E Mlator Gazoline 216 - 2135 ] 4283w 5728 =
Mator Gazoline Elending
| 20 | Compenents =] [ P o3| x azzs| 5342 | =
| 21 |Mise. Petio Products — e e a2 w ] =
E Petroleum Coke 1792 - 208 ] 1683 ] B3] w 51793 =
ﬂ Pentanes Plus - -1 ] ] 4206w =
A Riesidual Fuel -l - ] il ] L1 1775 =
25 |5til Gas. AB6 | [ 108 ] 7398 ] 4008 n 48,261 =
E kL 74 ] 388 ] 4347w = 8543 =
| 27 | Unfinished Dits 878 -( il o) ). 1879 « a44z) = (He3) =
| 28 [viares ot il 53| )= il a6l @ n = =
E Matural Gas. BEA33 | [ 2283 ¥ 59%‘ 1= B5,160 ¥ e w ul o= 108,313 =
| 30 | Other N ( il | e il u = =
E
22 |Industrial Sector 1991 I+ ibefault Non-Energy Consumption bata? |
Ex] Total Mon-Energy Net combustible
E Consumption Consumption Consumption  Emission Factor ~Combustion Emissions Emissions Emissions
35 | Fuel Type (Billion Btu) (Billion Bu)  Storage Factor %) _ {Billion Bt} (Ibs CiMillion Btu) Efficiency () (short tons carbon) [MMTCE) (MMTCOE)
= PO ) e e ey e ey e s

Step (10) Review Summary Information

The steps above provide estimates of total carbon in fossil fuels consumed, carbon stored in
non-energy products, and amount of carbon oxidized to CO2. Total carbon emissions are
equal to the total carbon content in fuel, minus carbon stored in non-energy uses, adjusted
for the carbon not oxidized during combustion, and summed over all fuel types and sectors,
for each year. The information is collected on the summary worksheet, displaying results in
MMTCO:2E. Figure 9 shows the summary worksheet that sums the emissions from all
sectors in the CO2FFC module. In addition, the results are displayed in graphical format at
the bottom of the summary worksheets.
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Figure 9. Example of the Emissions Summary Worksheet in the CO>FFC Module

A B C D E F G H | J K L M N o} P
1 10. Alabama Emissions Summary (MMTCOZE) o lo the Contral | | Review discussion of
Sheet uncertainty associated
2 with these results
3
4 Aggregated Summary Table
5 MMTCO2E 1990 1991 1992 1993 1994 1995 1996 1997 1998 1999 2000 2001 2002 2003
6 Residential 3.10 3.03 321 343 3.31 333 374 3.36 312 3.33 3.08 S 3.26 3.09
7 Caal 0.05 001 0.04 0.02 0.00 0.00 0.01 002 0.00 001 001 0.00 0.00 0.00
8 Petroleum 0.68 0.61 047 0.61 0.69 0.62 0.63 0.66 0.6b 0.98 104 0.85 072 0.6b
9 Natural Gas 2.48 251 270 281 272 271 3.10 2.68 256 234 263 270 254 254
10 Other - - - - - - - - - - - - - -
11 Commercial 244 2.00 211 2.00 2.060 197 217 243 191 2.20 2.20 217 2.00 211
12 Caal 0.20 003 017 0.08 o0.02 0.01 0.09 0.15 0.02 0.05 011 0.03 001 001
13 Petroleum 0.92 0.68 0.67 0.68 0.64 0.62 049 0.49 047 0.63 073 0.70 0.63 072
14 Natural Gas 132 1.29 137 141 139 143 159 179 142 152 142 144 137 138
15 Other - - - - - - - - - - - - - -
16 Industrial 16.14 16.61 19.22 1812 19.02 19.89 20.62 20.24 19.10 19.64 1937 1714 17.40 1849
17 Caal 508 5.53 7407 512 556 5.56 5.82 6.02 5.63 5.61 540 5.34 499 4.90
18 Petroleum 3.20 2.83 2.98 313 .64 332 3.81 346 2.88 3.01 2.90 3.22 3.68 4.69
19 Natural Gas 7.86 8.256 LAYS .86 9.81 11.00 10.88 1076 10.60 11.03 1.07 8.58 8.83 8.8%
20 Other - - - - - - - - - - - - - -
21 Transportation 20,69 26.94 27.84 2797 29.37 30.83 30.27 29.96 30.96 3139 32.61 30.91 32.46 3190
22 Caal - - - - - - - - - - - - - -
23 Petroleum 26.89 26.04 26.82 27.12 28.66 29.73 29.22 28.81 29.86 3017 3136 29.82 326 3087
24 Natural Gas 0.80 0.50 1.02 085 0.82 110 1.05 115 L0 122 126 110 Lig 1.04
25 Other - - - - - - - - - - - - - -
26 Electric Power 5140 bb.39 b8.24 64,01 59.93 65.57 70.84 69.04 TLIO 72.39 7742 7455 78.19 79.09
27 Caal 51.04 55.04 57.92 63.62 59.54 65.01 70.30 68.29 69.39 70.89 7491 70.52 7182 7419
28 Petroleum 0.06 o007 0.06 0.06 0.09 008 013 0.10 0.20 0.13 0.20 0.23 0.16 0.20
29 Natural Gas 0.30 0.28 0.26 033 0.30 048 041 0.65 151 138 2.30 3.80 6.11 469
30 Other - - - - - - - - - - - - - -
31 International Bunker Fuels 146 179 169 144 126 131 127 120 0.80 0.74 Li6 0.65 a7 0.90
32 Petraleum 146 179 159 144 126 131 1.27 1.20 0.80 074 116 0.65 1.07 0.50
33 TOTAL 99.77 103.97 110.63 115,50 113.70 121.58 127.54 125.02 126,19 128.94 135,34 128.33 133.31 134.68
34 Coal 56.37 60.62 65.20 68.84 65613 70.60 76.23 7448 75.03 76.65 8044 75.89 76.92 79.10
35 Petraleum 30.64 30.13 30.90 3149 3353 34.27 34.28 3362 33.06 34,01 36.23 34.82 36.34 37.03
36 Natural Gas 12.76 13.23 14.62 16.26 16.04 16.71 17.03 17.02 17.19 17.48 18.67 1762 20.04 18.6b
7 Other - - - - - - - - - - - - - -
38
39
40 Summary Table by Fuel
41 MMTCO2E 1990 1991 1982 1993 1994 1995 1996 1997 1998 1999 2000 2001 2002 2003
42 Residential 3.10 3.03 321 343 3.31 3.33 a7 336 312 3.33 3.68 355 3.26 3.00
43 Coal 0.05 001 0.04 002 0.00 0.00 0.01 002 0.00 001 001 0.00 0.00 0.00
44 Distillate Fuel 0.01 001 0.00 001 0.00 0.00 0.00 002 0.00 0.00 001 o0.02 0.02 0.00
45 Kerosene 0.02 0.03 0.0t 0.02 0.01 003 003 0.02 0.02 0.02 0.02 0.02 0.0t 0.02
46 Hydrocarbon Gas Liquids 0.55 047 045 058 0.57 059 0.60 062 053 0.96 1.01 0.82 0.6% 053
47 Natural Gas 2.48 2.61 2.70 2.81 272 271 3.10 2.68 2.56 2.34 2.63 2.70 2.54 2.54
48 Other - - - - - - - - - - - - - -
49 Commercial 244 2.00 211 2.06 2.06 1.97 217 243 191 2.20 2.26 217 2.00 211
50 Coal 0.20 0.03 017 0.08 0.02 0.01 0.09 0.16 0.02 0.06 011 0.03 0.0t 0.0t
51 Distillate Fuel 0.32 0.32 0.33 033 0.40 0.28 0.24 023 0.24 0.25 033 0.36 0.34 047
52 Kerosene 0.00 0.01 0.01 0.01 0.00 0.00 0.00 0.00 0.01 0.00 0.00 0.01 0.01 0.01
S8 Hydrocarbon Gas Liquids 0.21 0.18 017 023 0.22 0.22 0.23 0.24 0.20 037 039 031 0.27 0.22
54 Motor Basoline 0.10 0.06 0.06 0.02 0.02 0.02 0.02 0.02 0.02 0.02 0.02 0.02 0.02 0.02
> Control Default State Energy Data Table Residential Commercial Transportation Industrial Electric Power Bunker Fuels Summary-MMT ...

Step (11) Export Data

The final step is to export the summary data. Exporting data allows the estimates from
each module to be combined later by the Synthesis Module to produce a comprehensive

greenhouse gas inventory for the state.
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To access the “Export Data” button, return to the control sheet and scroll down to the

bottom (11). Click on the “Export Data” - -
button and a message box will open that Note: the resulting export file should not be

reminds the user to make sure all steps of modified. The export file gontalns a summary
worksheet where users can view the results, as well as a

the module have been completed. If you separate data worksheet with an unformatted version of
make any changes to the CO2FFC module the results; this data worksheet contains the information
later, you will then need to re-export the that is exported to the Synthesis Tool, and it is especially
results. important that users do not modify it. Adding/removing

rows, moving data, or making other modifications
o ] jeopardize the ability of the Synthesis Module to
Clicking “"OK"” prompts you to save the file. accurately analyze the data.

The file is already named, so you only need

to choose a convenient place to save the
file. After the file is saved, a message box will appear indicating that the data was
successfully exported.

While completing the modules, you are encouraged to save each completed module; doing
so will enable you to easily make changes without re-running it entirely.

Following data export, the module may be reset and run for an additional state.
Alternatively, you may run the remaining modules of the State Inventory Tool to obtain a
comprehensive profile of emissions for your state.

1.4 UNCERTAINTY

In the upper right-hand corner of the summary worksheet is a button: “Review discussion of
uncertainty associated with these results.” By clicking on this button, you are taken to a
worksheet that discusses the uncertainty surrounding the activity data and emission factors,
and how the uncertainty estimates for this source category affect the uncertainty of the
emission estimates for your state.
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